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Machining
Machining is the process of removing material from a workpiece. This is a common process for creating parts, especially metal 
parts.  Machine tool setups hold a cutting tool or abrasive wheel, hold the workpiece, and then provide for relative motion 
between the two in order to produce the desired surface. 

The DFM Concurrent Costing software can be used to model the machining of parts that are formed by another process as well 
as the machining of parts from a stock shape of material.  The following tutorial shows the two different methods that can be 
used to model a part that is machined completely from stock.

Parts machined from stock can be analyzed in the program in two distinctly different ways; with Dynamic Costing either turned 
on or turned off.  When Dynamic Costing is turned off, the analysis is based on the definition of the individual machine tool 
setups and the individual machining operations that are performed on each setup.  When Dynamic Costing is turned on, it is 
no longer necessary to define individual machine tool setups and machining operations.  Instead, the overall shape of the part 
is classified, and then various types of part features are defined.  The program uses that information to automatically calculate 
a suitable machining process and the resulting part cost.  With Dynamic Costing turned on, there is also an option for the 
software to determine the important cost drivers for your specific part which makes the machining analysis easier and faster to 
complete.

The first part of this tutorial will guide you through a machining analysis with Dynamic Costing turned on while the second part 
of this tutorial will cover a machining analysis with Dynamic Costing turned off.

The part analyzed in this tutorial is a hollow cylinder base that is cut from bar stock and then has various machining operations 
performed on it using a turning center.  A dimensioned drawing of this part is shown below and the completed DFM 
Concurrent Costing analyses are contained in the sample file cylinder.dfmx that has been included with your installation of the 
software (\data\samples).
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Part 1

Begin the analysis
1.	 In a new analysis, complete the part description as shown here:

2.	 Accept the default forming direction shown above because this is the direction in which the bar stock would have been 
produced.

3.	 Double-click the Original name on the tab above the Process Chart. Type Dynamic Costing ON and press the Enter key.

4.	 Click the Select process and material button.

5.	 On the Process and Material selection window choose Machining or cut from stock for the process and then expand the 
Stainless steel material category and choose Generic stainless steel.  Be sure the 23A BDI North America manufacturing 
profile is selected.

6.	 Click OK to return to the main window with the responses for the Stock process entry displayed on the right panel.

7.	 In the response panel on the right, turn On Dynamic Costing.  The Dynamic Costing lightning bolt changes to solid and a 
Machining operations entry is added to the Process Chart, as shown below.
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8.	 A default Dynamic Costing estimate for the machined part has been generated by the software and now this default 
estimate will be refined to make it more accurate.

9.	 Note that the stock material form is defaulted to round tube because the hollow cylinder part envelope shape was chosen 
at the beginning of the analysis.  This part will actually be machined from solid bar, so select Round bar or rod for the stock 
material form. Click Calculate in the Cost results box.

10.	Leave the cutoff method set to Abrasive cutoff.  The default values for material cost and scrap value come from the material 
library and any edits made here to these defaults apply only within this analysis of the part.

11.	When Dynamic Costing was turned on, the Volume and Weight displayed in the Part geometry section were defaulted to 
half of the values for the original workpiece.  These values are used to estimate the amount of material removed during 
machining and they affect the software’s estimate of the rough machining time required.  For this analysis, we know the 
volume of the finished cylinder so change the Volume to 20.74 and click Calculate to update the Weight field and the cost 
results.

12.	Click the Workpiece entry on the Process Chart and then review the responses on the right panel.  Here, the fields that 
affect workpiece cost and volume prior to machining are recorded.

13.	Click the Abrasive cutoff entry on the Process Chart and then review the responses on the right panel.  For this analysis, we 
accept these default values which include the hourly rates and setup time for the cutoff operation.

14.	Click the Machining operations entry on the Process chart.  The cylinder is a turned part with drilled and tapped holes 
in its flange as well as milled grooves in its body.  These part features require live tooling on the lathe during machining 
which means the part should be classified as a rotational part with secondary features.  For that reason, click the Primary 
rotational & secondary button.  The response panel updates, as shown below.
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15.	Uncheck the Show important inputs only? box and note that the response panel displays all of the inputs needed to 
completely describe a rotational part with secondary features, as shown below.
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16.	Check the Show important inputs only? box and note that the program displays a much smaller list of inputs, as shown 
below.  This list reflects the most important cost drivers for the analyzed part, and it will vary depending on the conditions 
defined in the analysis.  Focusing your analysis on these questions minimizes the time and effort required to analyze a part 
while also minimizing errors in the cost results.
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17.	Finish turning of the cylinder is carried out on the outside and inside faces of the large flange, the outside face of the small 
flange, and the central bore. For these features, enter 4 into the Finish machined turned features input.  Click Calculate to 
update the response panel and note that the list of important inputs has remained unchanged.

18.	Enter 4 for the Drilled secondary holes input to account for the four secondary holes that are drilled into the large flange.  
Click Calculate to update the response panel and note that the Finish machined planar features input has been added to 
the list of important cost drivers shown on the response panel.  The cylinder has no finish machined planar features so it is 
unnecessary to modify the zero default value for that input.  There are also no ground rotational or planar features on the 
part and no broached or gear features which means the zero default values for those inputs apply.  The machining analysis 
of the cylinder, with Dynamic Costing turned on and important cost drivers specified, is now complete.

19.	Click the top-level of the process chart and note that the total cost result is $51.6188 per part.

Part 2
In the second part of this tutorial, a copy of this analysis will be used to analyze the same part with Dynamic Costing turned off 
and then the cost results will be compared.

20.	Click the Dynamic Costing ON analysis tab at the top of the Process Chart.  Click the Edit menu at the top of the window 
and then click Copy.  Click the Edit menu at the top of the window again and then click Paste to create a copy of the analysis 
tab.

21.	Double-click the rightmost Dynamic Costing ON analysis tab and change its name to Dynamic Costing OFF.

22.	Click the Stock process entry on the Process Chart and, in the response panel on the right, turn off Dynamic Costing.



� / A Machining Analysis

DFM Concurrent Costing® Software Tutorial

DFMA Software by Boothroyd Dewhurst, Inc.

Adding a machine tool setup
23.	Add a machine tool setup.  Click the Insert menu at the top of the program window and then click Machine 

Tool Setup on the menu.  In the dialog that opens, expand the Lathes category, if necessary.  Click the Shenyang 
HTC2050im CNC Lathe machine.

24.	Click the Insert button to add the machine to the Process Chart.

25.	Close the Insert machine dialog and view the responses for the lathe.

26.	Note that the batch size and the material hardness can both be changed for individual setups. For this analysis we 
will accept the default values.

27.	Also note that the Rejects, % input appears in the Basic data group box. This is the percentage of parts rejected 
after all operations on the setup have been completed.  The cost allocated to each acceptable part because of 
these rejected parts is shown in the Cost results panel, underneath the Process Chart.

28.	Note the Result box on the Responses Panel where the total cycle time and the total setup time are both displayed 
for the setup. These will be recalculated and updated as machining operations are added to the setup.

29.	Click the Setup/load/unload Process Chart entry that appears beneath the machine and review the responses on 
the right panel.  Here, the hourly rate and the time required to set up the machine tool can be specified along with 
the cost of any required fixtures or programming.

30.	In the Work handling box, choose 3-jaw chuck from the Workholding device dropdown list. Change the Number of 
reversals to 1 because the part must be reversed in the chuck and machined from both ends.

31.	Click the Calculate button to update the Cost per part results.

32.	Add machining operations to the setup. With the Setup/load/unload operation selected on the Process Chart, 
Choose Operation from the Insert menu to open the Insert Operation dialog.

33.	Expand the Machining category and then the Drilling subcategory. Highlight the Drill single hole operation and 
click the Insert button to add it to the machine.  Close the Insert Operation dialog.

34.	The Responses Panel shows a picture of the drilling operation with appropriate dimensions labeled to simplify the 
specification of cut dimensions. Results are not calculated until the dimensions have been entered.



� / A Machining Analysis

DFM Concurrent Costing® Software Tutorial

DFMA Software by Boothroyd Dewhurst, Inc.

35.	Enter 1.5 inches for the hole diameter (dh) and 6 inches for the hole length (lh). Change the tool material selection to 
Carbide. See that the box remains checked to include the tool replacement cost.

36.	Click the Calculate button to update the Cost per part results.  The Responses Panel for the operation appears as shown 
below.

Note that the Maximum power required and the Maximum spindle speed required are both below the available values on 
the selected machine.  This indicates the drilling operation is not limited by the machine and will be carried out at optimal 
machining conditions.

The special tooling cost input is used to specify the cost of any special fixtures or other special tooling that is not included 
elsewhere.

The Operation time result includes the time to position and change the tool whenever necessary.  Default values for the tool 
positioning time and the tool change time are available in the responses for the machine tool.

The remaining machining operations would now be added to the analysis in the very same way until all of the machining 
required to produce the part has been described.  
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View the completed sample analysis
37.	Click the File menu at the top of the program window and then click Open.  In the Open dialog, navigate to the \data\

sample folder if necessary and open the Cylinder.dfmx analysis file.

38.	The leftmost analysis tab in this sample file contains the machining analysis, with Dynamic Costing turned on, that was 
completed during the first part of this tutorial.  The rightmost analysis tab contains a completed version of the analysis 
started in the second part of this tutorial, where Dynamic Costing was turned off and all the individual machining 
operations defined.

39.	Click the Results menu at the top of the program window and then click Cost Totals to display the graph.  Click the 
toolbar button to display the Pie chart and then, on the right side of the graph window, check the boxes to compare both 
analyses, as shown below.

Discussion of results
The most detailed and accurate cost estimate is achieved from the analysis completed with Dynamic Costing turned off where 
each individual machining operation has been defined and each movement of the cutting tool has been accounted for.  The 
analysis done with Dynamic Costing turned off also provides a very detailed breakdown of machining costs so that the cost of 
each individual part feature can be estimated and examined.  The total cost per part result shown on the graph for this analysis 
is $50.3587.

With Dynamic Costing turned on, the program automatically made a tradeoff between the time and effort required to 
complete the analysis and the accuracy of the cost results.  For this part, the analysis done with Dynamic Costing turned on has 
resulted in an approximate cost result of $51.6188.  

40.	Mouse over the gray Difference pie piece and note that a pop-up message displays to indicate the error in the analysis with 
Dynamic Costing turned on is $-1.2601 or roughly 2.44%.  The magnitude of this error, on a percentage basis, is fairly typical 
for an analysis completed with Dynamic Costing turned on.
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41.	Click the  toolbar button to display the comparison bar chart, as shown below.  This graph enables easier comparisons 
of the individual cost results for the two analyses.

As you can see from the graph, the two analyses have the same material cost result.  This is because the part material cost is 
estimated in the same way regardless of the type of analysis done.  In this case, more than 74% of the part cost is due to the 
cost of the part material.  This means nearly 3/4 of the estimated cost does not depend on the type of analysis done and all 
of the approximations made when Dynamic Costing was turned on only affected 1/4 of the cost estimate.  This is very typical, 
and for most machined parts the cost of material makes up more than half of the part cost.  This is one reason why using 
Dynamic Costing has a negligibly small impact on the overall cost results for machined parts.  And this means the benefit of the 
substantially reduced effort needed to complete the analysis of a machined part can be realized without substantively affecting 
the cost results.

The setup and rejects costs are both very small, which means the impact of the Dynamic Costing approximations in these 
results are also very small.  With Dynamic Costing turned on, the setup cost was overestimated by $0.3736, and the rejects cost 
was also overestimated by $0.0053.  This shows that the Dynamic Costing approximations in these costs have contributed to a 
difference of $0.3789 in the overall estimate of part cost and most of that difference was due to approximations in the estimate 
of setup cost.  This is typical for machined parts that are produced in medium to high production volumes and in these cases 
the Dynamic Costing approximations will result in only small errors in the setup cost per part.

With Dynamic Costing turned on, the process cost has been overestimated by $0.8813, which accounts for most of the cost 
difference between the two analyses.  This difference is primarily due to the way the machining non-productive time has been 
estimated by the program.  With Dynamic Costing turned off, each movement of the cutting tool has been defined directly and 
has been accounted for in the analysis.  However, when Dynamic Costing is turned on, the program automatically estimates the 
number of cutting tool movements and, in this case, the program overestimated the value.  The effect of this non-productive 
time on the machining cost tends to become larger for machined parts that are smaller in size.  This means the approximations 
used when Dynamic Costing is turned on will generally yield reasonable results for all but the tiniest of machined parts and the 
Dynamic Costing turned on cost estimate tends to improve as machined parts increase in size.


